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Update 242 and Full Install 
 

Update Download Link: 

http://www.ostendo.info/downloads/ostendo/update242.exe 

• As with any update you should perform a Firebird Validation / Backup and Restore of all 

databases prior to running the Upgrade. 

• If you have multiple instances of the API service running, ensure they have all been stopped 

prior to the upgrade and re-started upon completion. 

• If Queue / Web Services are active, these should be stopped prior to the upgrade and re-

started upon completion. 

 

Full Install Download Link 

http://www.ostendo.info/downloads/ostendo/ostinstall.exe 

 

Technology 
 

Tile Control 
Tile Templates (Collections) allow a Windows style Tile Control User Interface to be used 

with Ostendo to shortcut to areas both within Ostendo and outside of Ostendo eg: URL 

Links. 

By default, Ostendo has one System Default Tile Collection that is specified globally at a 

System level. (You cannot modify this). Below this level, Users can be linked (via their 

Security and Options) to specific default Collections. 

If no Collection is defined at a User Level, the System Level is used. 

At an Administration level , new Tile Collections can be created (eg: Manufacturing, Sales 

etc..) and linked to appropriate users. These Collections can have custom, Tiles, Tile Colours 

or a Tile graphic to represent the Tile shortcut. 

Once the Custom Collection is linked to a user, (User Security Options) individual users can 

further control their specific Tiles presented under their profile. In essence the Tile 

Collection is used initially as a default (Reset). From that point on, the user can customise 

their version of that Collection to suit their own requirements. This can be done on the Tile 

screen itself. The user can control the following attributes: 

• Amend the Collection Title 

• Add  / Move / Delete Individual Tiles 

• Amend Tile Captions 

• Amend Tile Sizing to Small / Large (Rectangle) / Extra Large 

• Assign Buttons to Ostendo options eg: specific Reports / Inquiries, screens etc. 

• Create  / Rename Tile Groups 

http://www.ostendo.info/downloads/ostendo/update242.exe
http://www.ostendo.info/downloads/ostendo/ostinstall.exe
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• Reset entire User Tile Customisation back to the Standard Tile Collection linked to 
that User 

 

User Customisation of the Standard (System) Template 
 

Right click anywhere on the screen (black area) to control these attributes. 

 

• Title Button – Allows you to amend the overall Template Title Displayed 

 
• Reset – This will reset the overall template back to its System Default 

• New Tile – Allows you to define a New Tile 
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o Assign From Menu – When this is selected, you must then navigate to an Ostendo 

option from the Main Drop Down Menus. This will create a new button with the 

appropriate Title. You are then able to drag that button to another group if required. 

o URL – Allows you to define a URL to enable the button to launch your browser 

o File – Allows you to browse to a file to enable this file to be opened when the new 

tile is selected. 

 

Customising a Tile (button) 
To customise an existing button, Right Click on the Button and the following options will be 

displayed at the bottom left of the screen. 

 

 

 

• Clear Selection – Disregard the selection 

• Small – Changes the Tile to a Small size 

• Large – Changes the Tile to a Large size (Rectangle) 

• Extra Large – Changes the Tile to an Extra Large size 

• Properties: 

o Caption – Changes the Tile Heading 

o Caption Colour (Black or White) 

o Icon – Allows you to select an appropriate Icon for the Tile 

o Colour – Changes the Background colour if Background is not selected. 

o Background – Allows you to Load an Image into the background of the Tile (Right 

Click in the background section of this field) 

• Assign – Allows you to re-assign this Tile to a different Ostendo Option 
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Creating Desktop Collections: 
File -> Desktop Tile templates -> Tile Collections 

This option allows you to create a new base Template Name (Collection) which you will then be able 

to specify Tiles to later. Eg: Sales 

Press the Add button to create a new Tile Collection Name 

• Name – Must be a unique name 

• Description – Provide a description of this Collection Name 

• Background Image (optional) – This allows you to save an background image against this 

Collection name. This image will be displayed instead of the std default image if none is 

specified.  

NB: Ensure the Image size is 2560 x 1080 pixels, otherwise the image will appear tiled on the 

screen. 

 

Creating and Linking Desktop Tiles to a Collection 
File -> Desktop Tile Templates -> Desktop Tiles 

This screen allows you to manually Add Tiles and configure those tiles against a Tile Collection 

 

 

• Collection Key – Select the Collection to link this Tile to 

• Link Type – System Action / URL / File 

• Link Value – Select this according to the Link Type you have selected 

• Caption – This is the Tile Heading 

• Image – Select the Icon you wish to display for this Tile 

• Background Image – Allows you to Load an Image into the background of the Tile (Left 

Click, then Right Click in sub screen section of this field) 

• Tile Size – Small / Regular / Large / Extra Large 

• Tile Colour – Define a colour if you do not specify a Background Image 

• Caption Colour (Black or White) 

NB: When defining Tiles in this manner, all tiles will be grouped together in one group.  

 

Linking The Tile Collection to a User: 
File -> System Configuration -> User Security & Options -> Options Tab 

This option allows you now to link this collection to a specific User(s) 

• Turn Off Tile Display – When selected, this indicates No Tile displayed for this user 

• Tile Collection Name – This is the Collection Name you wish to associate with this user. 
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When the user logs onto Ostendo they should right click somewhere on front screen and select the 

‘Reset’ option. After that the user can drag tiles around and create Groups specific to their own 

requirements. 

 

 

 

Grid List Customisation Now displays fields in alphabetical sequence with the already shown field 

at the top of the list. 
 

Queue Service Settings 
We now have the capability of configuring Queue Settings to use TLS Protocol  

 



 

 Update 242 Release Notes Page 6 of 12 
© Copyright 2021 Development-X Limited  

 

Jobs 

• Job Deliveries 
This is a new process, NOT exclusive to Container tracking. Ie: You can use this process even 

if you are not using Container Tracking. 

 

A new process has been developed for dealing with Job Deliveries. We make use of the 

existing Sales Deliveries process and screens by linking to a Job and Job Task instead of a 

Sales Order.  

 

Previously the Job Transactions screen was used to process Job Deliveries, however this 

involved numerous steps (This screen and process will remain for those wishing to continue 

with this existing process) 

 

A Job Delivery can now instead be initiated from a “Deliveries” button on the Job Screen. 

This will shortcut you through to the Sales Deliveries screen. In essence, this allows you to 

manually create a ‘Delivery’, however in this case the Delivery itself is to be linked to the Job 

and Job Task (NB: The Task must be set to “Multiple Job Lines can be linked to this Task”).  

 

Once the Delivery has been created, you are able to pick the lines against this delivery and 

optionally record each item picked into a Container. ie Goods for the delivery maybe 

physically put on a container to be delivered to the customer. This means the Delivery Pick 

and or Drop Off processes can be handled through Freeway in the same manner as current 

Sales Deliveries are handled. 

 

Job Orders Screen (New Button – “Deliveries”) 

This takes you to the Create Deliveries screen where you can create the Delivery and 

optionally select a Job Task if there are multiple tasks on the job. 

 

Job Deliveries Screen (Detail Screen – Close Delivery Button) 

This screen behaves similarly to the current Sales Deliveries screen however after you have 

picked the lines, and returned to the Detail Tab and pressed the ‘Update Delivery Status to 

Shipped’ you can then press the ‘Change to Closed’ Button to close-out the Job Delivery. 

 

Alternatively you may optionally choose to leave this delivery as ‘Shipped’, then when either 

the Job Task or the Job itself is ‘Closed’, any ‘Shipped’ deliveries will be automatically closed 

at that point. 

 

• Batch Entry screen (launched from within Order Lines) for Item / Descriptor / Lists etc.. 
selection screen now has a splitter to allow the user to expand the height of either panel 

 
• Job Transactions (Delivery Style) was returning the Postal Address if a Supplier was 

selected as a Delivery Address. This now returns the default Physical address from the 
Supplier. 

 

• PO Mandatory error message was being displayed when changing a Job from Planned to 
Open when that customer was not set to mandatory PO - now resolved 
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• Taskbill Contents only displaying Std Sell Price. Therefore no Customer Pricing rules were 
being run. Amendment to Stored Procedure so that when a new Content line (Item or 
Descriptor) is inserted the RETURN_PRODUCTUNITPRICE procedure is run. NB: If a Qty is 
amended, this procedure will not re-run to determine Qty Breaks. Therefore user must 
delete line and re-enter it with the Amended Qty Per value  – now resolved 
 

• Labour Code Issues - Decimal Precision level for Labour codes when joblinesactuals posted 
is being rounded to 2 decimals, whereas Descriptors etc.. are rounded to 4 decimals – now 
resolved 

 

Sales 
• Batch Entry screen (launched from within Order Lines) for Item / Descriptor / Lists etc.. 

selection screen now has a splitter to allow the user to expand the height of either panel 
 

• Recurring Invoices 
o Now allows for a unit price to multiple decimals (previously only allowed 2 decimals) 
o Includes a Contract Information field irrespective of Style. Previously it was not 

shown for Customer Asset Style Invoices. 
o Contract Information field now available in the Detail screen on Asset Recurring 

Styles 
 

• Sales Delivery - Delivery Refresh Button. When this button was pressed, this was inserting 
SO lines without conditioning on the Required Date for that Delivery – now resolved 
 

• Deposits that were fully applied with small amounts left are still showing on Customer 
Statements. Amendment the Stmt procedure to ignore any Deposit Aging records where the 
Status was Fully Applied in co-ordination with the Aging Date. 
 

 

Assembly 
• Batch Entry screen (launched from within Order Lines) for Item / Descriptor / Lists etc..  

selection screen now has a splitter to allow the user to expand the height of either panel 
 

• Assembly Order - Lines Tab now includes a splitter to allow the user to expand the height 
of the Actual Issues portion of the screen 

 

• Assembly Actual Issues Move can now be moved from one Assembly Order to another 
(similar to Jobs). This can be performed by right mouse clicking on the Assembly Actual Issue 
Record and selecting “Move Issue to another Assembly”  
 

POS 
• Price Level has now been included in the POS Customer screen (F4 from POS) 

 

• Inactive Units were being presented in the POS “Multiple Records” selection screen if the 
item had multiple unit records. These are now ignored 

 



 

 Update 242 Release Notes Page 8 of 12 
© Copyright 2021 Development-X Limited  

 

• Security Permissions - POS Customer Screen (F4) from POS screen. This screen now 
determines the Ostendo users permissions settings controlling whether they can amend the 
Credit Terms on the POS transaction. The Terms cannot be changed for users whose security 
settings prevent them from launch the ‘Customer’ screen 

 

Inventory 

• Container Tracking Module 
This new module allows product to be containerised and maintained via Freeway. Detailed 

information can be found in the Container Tracking Module White Paper. 

• Go To Invoice (right mouse click navigation option) added to  
Inventory Availability -> Transaction History tab for Direct Invoices and POS Sale Invoices 

 

• Inventory Labels screen can now be minimised allowing the user to keep it open whilst 
moving to other areas in Ostendo. 

 

• Item Nutrition (New Screen): 
Related Screen from the Item Master  

or Inventory -> Item Nutrition 

This screen enables you to record nutritional information about the product. The idea is that 

eventually this information will be uploaded to Ostendo.Work to enable outside parties to 

scan a 2D Barcode to enable a Standalone Freeway solution to draw down this information 

as required. The Barcode value itself will be a Global Unique ID (ie: this code is unique across 

all Ostendo databases) 

In addition, you could include this information (or even just the 2D Barcode) on reports 

generated from within Ostendo eg: Packing Slip or Delivery Documents. 

From the List Grid of this screen, press the Add button to create a nutritional information 

record for this item. 

Detail Screen: 

• Item Code: Select the Item Code to link to this nutritional information 

• Nutritional Description: Type in a relevant Nutritional Description eg: Servings per 

package 2. Serving Size 210g 

• Per Serving Caption: eg: “Avg Qty Per Serving 210g” 

• Per Weight/Volume Caption: “Avg Qty Per 100g” 

• Per Serving Daily Intake % 

• Ingredients Notes:  

• Serving Notes: 

• Storage Notes: 

• Origin Notes: 

• Allergen Notes: 

Info Screen: 

• Nutrition Line: eg: Energy or Protein 

• Per Serving Value: eg: 840kj 
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• Per Weight/Volume Value: eg: 400kj 

• Per Serving Daily Intake eg: 5.5% (NB: This is a text field) 
 

• Item Shipper Labels (New Screen): 
Related Screen from the Item Master  

The concept behind this is to allow Delivery picking of Shipper cartons which contain 

multiples of the same SKU.  

Eg: You may stock a SKU called ‘Spanners’ with a UOM of Each, however they could be 

physically stored in Shipper boxes of containing 50 in each box. In this case you would setup 

a Shipper record with a Shipper Quantity of 50. You can then print off Shipper Barcode labels 

to attach to each shipper box. Then when the warehouse person scans that shipper box for a 

delivery pick from Freeway, Ostendo would interpret that pick qty of 50. 

If the delivery required a pick qty of 56, the warehouse person could scan one shipper label 

to pick 50, then scan the individual SKU barcode label and pick the remaining 6 

Essentially Ostendo is interpreting the Shipper Label barcode and picking a qty according to 

that Shipper size.  

Further to this, When the Delivery is initially created, a new display only field is populated 

against each Delivery Line with a ‘Suggested Picking Instruction’ eg: “pick 1 shipper of 50 and 

6 single units”. This is only a suggestion, and therefore could be ignored if no shippers are 

physically available for that item. The idea here is that this extra piece of information assists 

the warehouse picker in determining the best configuration to pick for that item on the 

delivery. 

List Tab 

▪ This shows all items where Shipper Labels have been defined 

Detail Tab 

▪ Shipper Quantity – This is the quantity that will be stored in this shipper 

▪ Shipper Description – This is the Name given to the Shipper eg: Box (50) or 

Box (100) etc.. 

• Item Batches Screen: 
o A new field “On Hand Qty” has been added to this screen to display the current 

stock on hand for each batch recorded in the Item Batches screen. (NB: Please be 

aware that this will only show On Hand Qty for those inventory records that have 

corresponding Item Batch records). 

o A new field “Supply Batch No” has been added to display the Suppliers Batch 

Number for this item if this was recorded on the Purchase Receipt Allocations screen 

at the time the goods were receipted (Refer Purchase Receipts Allocation Tab) 

Pricing 
• Batch Price Update – The following fields have been added / amended on the Lines screen 

o Value Difference (Difference between Old Price and New Price) 
o % Change (Between old and new value) 
o The Description will now include the Last Cost Date concatenated to it. 

Eg: “Main Controller [23/04/2019] 
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Purchasing 
• Related Option  - Supplier Contracts now has been added allowing shortcut to Suppliers. 

 

• Supplier Contracts – Scripting now includes this screen as a Related Menu option from 
Scripting 

 
 

• Supplier Code Refresh on PO Lines - The Supplier Code, Description and Unit was not 
being removed / refreshed on the PO Line Supplier Code Tab if the Supplier was changed on 
a PO 

 

• Purchase Header Email Address was not being refreshed if a Supplier was changed on a 
PO. Now refreshed with new supplier 

 

• Purchasing Docs created automatically by Queue Services for Freeway Datasheets were 
being created in a Folder called “Purchase-Docs”. This was in conflict with PO’s created 
manually in Ostendo if the General rule for Folders was turned on. In this case a “Purchasing-
Docs” folder was being created. Now only the “Purchasing-Docs” folder is used for both. 

 

• Multiple Supplier Buy Price Records - If a ‘Descriptor’ had multiple Buy price records for 

the same supplier, The first record was being read as the default Supplier Code which is fine, 
however if the Supplier Code was changed on the PO line (Supplier Code Tab), the 
associated buy price was not being returned to the PO line. 

 

• Batch Entry screen (launched from within Order Lines) for Item / Descriptor / Lists etc.. 
selection screen now has a splitter to allow the user to expand the height of either panel 

 

• Purchase Rule - How to Update Costs for Job/Assy Orders. The Assembly Order is being 
left ‘InProgress’ when a Purchase Receipt is processed against a Closed AO when the 
Purchase Rule is set to re-open and then Close the Order – now resolved 
 

• Supplier Catalogue Item Barcodes – When a Catalogue Code was converted to an Item 
Code, the Catalogue Item Barcode was not being transferred to the newly created Item Code 
– now resolved 

 

• Purchase Receipts Allocations Tab – A new field is available on the Allocations screen to 
record the Suppliers Batch Number for a Ostendo Batch tracked item. This enables you to 
record the receipt against your internal batch number as well as the suppliers batch number, 
thereby providing further traceability between the two. This Batch Number is also displayed 
in a new field on the Item Batches screen. (Refer Item Batches screen) 

 
 

Financial Configuration 
• Payment Methods screen. Currently no default Banking Method against Payment Method. 

Payment Methods screen "Mobility Banking Method" now applies this logic when a Payment 
is created in Ostendo. This in effect becomes a default Banking Method for that Payment. 
NB: The exe will be updated to change the Field label on the Payment Methods screen to 
become "Default Banking Method" 
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Mobility 
• Employee Mobility Settings – (Time Entry Tab)  The field “Mobility Team for Time Entry”  

value was not being copied to the new Mobility Employee when the Employee is set to 
Inherit Mobility Settings from another – now resolved 

 

• Mobility Rules - 2 new rules have been added to universally control the posting of materials 
to Jobs and Assembly Orders when Freeway Datasheets are returned to Ostendo. 
 

o Job Material Posting 
▪ Job Direct (Default): The issue of materials from Freeway will be posted 

directly to the job. 
▪ Job Transactions: When the Datasheet is returned to Ostendo a Job 

Transactions batch will be created (InProgress) thereby allowing a back 
office user to authorise and post the Material Issues to the Job.  

 
o Assembly Material Posting 

▪ Assembly Direct (Default): The issue of materials from Freeway will be 
posted directly to the Assembly Order. 

▪ Assembly Issues: When the Datasheet is returned to Ostendo an Assembly 
Issues batch will be created (InProgress) thereby allowing a back office user 
to authorise and post the Material Issues to the Assembly Order.  

 
 

Assignment Board 
• Related Button (Activity Calendar) has been added to the Assignment board to allow the 

user to easily window between these two screens. 
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Accounting Integration Documentation Links: 
 

MYOB AR Live 
Documentation: 
http://ostendo.info/downloads/ostendo/OSTENDO_MYOB_AR_LIVE_INTEGRATION.pdf 
 
Xero 
Documentation: 
http://ostendo.info/downloads/ostendo/OSTENDO_XERO_INTEGRATION.pdf 
 
QBO 
Documentation: 
http://www.ostendo.info/downloads/ostendo/OSTENDO_QBO_INTEGRATION.pdf 
 
MoneyWorks 
Documentation: 
http://ostendo.info/downloads/ostendo/OSTENDO_MONEYWORKS_INTEGRATION.pdf 
 
Sage Evolution V7.0 
Documentation: 
http://ostendo.info/downloads/ostendo/OSTENDO_SAGE_EVOLUTION_INTEGRATION.pdf 
 
MYOB Classic 
Link Program: 
http://www.ostendo.info/downloads/ostendo/myobostlink_121.exe 
Documentation: 
http://ostendo.info/downloads/ostendo/Ostendo_MYOB_Classic_Mapping.pdf 
http://ostendo.info/downloads/ostendo/Ostendo_MYOB_Classic_Posting.pdf 
 
Reckon Desktop  
Link Program: 
http://www.ostendo.info/downloads/ostendo/qbostlink_90.exe 
 
Reckon Hosted 
Link Program: 
http://www.ostendo.info/downloads/ostendo/reckonostlink.exe 

Documentation: 
http://ostendo.info/downloads/ostendo/Ostendo_Reckon_Hosted_Setup.pdf 
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